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5

5. Introduction

The primary reference for creating technical documents at Wireless Seismic, Inc. is the 
Microsoft Manual of Style. A soft copy of this document is stored on the Engineering 
Wiki, and in SVN:

 ♦http://path/Technical+Publications/
Writing+References+%26+Style+Guides
● MicrosoftManualofStyle-V3-617465.pdf
● MicrosoftManualofStyle4thEdition.pdf

 ♦http://path/ms_style_guide

Follow the guidelines in the Microsoft Manual of Style unless an exception is noted in this 
style guide. 

This style guide provides instructions on the FrameMaker style elements used for writing 
technical documents at Wireless Seismic, Inc.

NOTE
The overall document organization is that of a reference manual, rather than a 
tutorial or collection of user stories. 

If there is time at a future date, that type of content would be welcome, or 
perhaps that is how the training materials should or could supplement the user 
documentation. 
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6

6. Paragraph Formats

This section describes the paragraph tags and their usage. Paragraph tags affect the 
entire paragraph.

6.1 Address
This tag is used on the front and back matter for the company address:

Corporate Headquarters: 13100 Southwest Freeway, Suite 150  Sugar Land, TX 77478
USA  832-532-5080
Regional Office: 1172 West Century Drive, Suite 200  Louisville, CO 80027 USA  720-
242-9916
info@wirelessseismic.com  www.wirelessseismic.com

6.2 Body
This tag is used for all regular paragraphs. 

6.3 BodyWide
This tag is used when you need to extend to the left margin, for example to anchor a 
figure or caption.

6.4 Bullets
The following tags are used for bulleted paragraphs:

 Bullet – The bullet font is defined by the Bullet character tag.
● Bullet1 – The bullet font is defined by the Bullet1 character tag.

► Bullet2 – The bullet font is defined by the Bullet2 character tag.
– Bullet3 – The bullet font is defined by the Bullet3 character tag.

The bullet paragraph syntax is as follows:

[Bullet Symbol][tab][text][space][en dash][space][text]

Please note the following:

 Do not use a period unless the bullet is a complete sentence. 
 Use the BulletIntro character tag for the text to the left of the dash.
 The keyboard shortcut for an en dash is [ALT]+[0150] on the keypad part of your 

keyboard.
 Capitalize the first letter of the word after the dash.

If there is no dash separator, do not use the BulletIntro tag:

 Bullet
● Bullet1

► Bullet2
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6. Paragraph Formats

Bullet Boxes

– Bullet3

See “Bullets” on page 29 for information about character tags.

6.5 Bullet Boxes
These tags are used for paragraphs that use a check box and an underline:

 BulletBox

 BulletBox1

 BulletBox2

If you don’t see the underline, make sure that the right tab is not outside of the margin of 
the page and that you have inserted a tab character after your text.

See “Bullets” on page 29 for information about character tags.

6.6 Callout
Used as follows:

 On the Reference pages for the Notification text
 When a Note, Caution, Tip, or Warning has multiple languages, used for foreign language 

word instead of the NoteIcon, CautionIcon, TipIcon, or WarningIcon paragraph. See the 
end of “Notification” on page 55 for an example. 

The preferred method is to use Snagit to add callout text. See “8. Figures and Images” on 
page 33. RoboHelp doesn’t handle multiple items in a a single FrameMaker frame very well. 
You can use a table with multiple columns and multiple anchored frames. That seems to end 
up well after the conversion. 

6.7 Cautions
The caution tag is used to create a paragraph that describes a caution the user must take. 
The graphical elements are defined in the Reference Pages as a Frame. 

Cautions are inserted as a table (Notification). The icon goes in the left column and is part 
of the paragraph format (CautionIcon or EquipmentCautionIcon). You do not have to 
insert the graphic separately. The graphic itself and the text is stored on the Reference Page. 
The text is in the right column and is formatted as CautionText or CautionBullet. There 
are also French, German, and Polish options. When a caution appears in multiple languages, 
use Callout for subsequent rows. See the end of “Notification” on page 55 for an example.

CAUTION
Caution – A description of a potentially hazardous situation which if not avoided 
could result in minor or moderate personal injury. When possible, include: 1) 
The action required to avoid the hazard. 2) Details of the hazard. 3) The 
consequences of ignoring the caution.
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7

7. Character Formats

This section describes the character tags and their usage. Character formats are applied 
to selected characters. 

7.1 Bullets
There are four bullet levels controlled by paragraph tags. The character tag is used as 
part of the paragraph tag to format the bullet symbol. 

 Bullet – Used for the Bullet in a Bullet paragraph
● Bullet1 – Used for the Bullet in a Bullet1 paragraph

► Bullet2 – Used for the Bullet in a Bullet2 paragraph
– Bullet3 – Used for the Bullet in a Bullet3 paragraph

7.2 BulletBox
The BulletBox character tag is used as part of the BulletBox, BulletBox1, and BulletBox2 
paragraph tags to format the bullet symbol.

 BulletBox

 BulletBox1

 BulletBox2

7.3 BulletIntro
Emphasis used at the beginning of a bullet paragraph when there is an en dash 
(ALT+0150) separator:

 User interface – a window environment for controlling the product

7.4 Callout
Not currently used. 

The preferred method is to use Snagit. See “8. Figures and Images” on page 33. 
RoboHelp doesn’t handle multiple items inserted into a FrameMaker frame very well.

7.5 Code
Courier font used for commands embedded in regular text:

Display the list of files in the current directory by typing dir at the command line. 
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7. Character Formats

CrossReference

7.6 CrossReference
Used for formatting cross-reference text:

See “12. Cross References” on page 63 for instructions. 

This is part of the Cross-Reference formatting when you insert a cross reference. You should 
not have to apply this separately. You can use it manually for names of document references. 
For example: see the System Description Guide, Colors section for more information.

7.7 Emphasis
Used to emphasize text:

To enable logging, select the check box. To disable logging, clear the check box. 

Do not use single or double quotes for emphasis. 

7.8 EquationVariables
Not used. 

7.9 FooterSmallFont
Used for the copyright information in the footer. 

7.10 HypertextLink
Used to format links to Web sites:

For complete terms of use, refer to http://www.wirelessseismic.com/legal.

In FrameMaker, this is not an actual link unless you insert a hypertext link separately
(Special → Hypertext).

7.11 NavigationIcon
Used for the arrow icon in at the left side of the Navigation paragraph.

→ File → Open

7.12 RedCheck
Used the CheckPrerequisite bullet:

1 Check prerequisites:
 The file is open

7.13 RightArrow
Used between words in a navigation paragraph.
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8

8. Figures and Images

Legible, relevant graphics enhance usability and visual appeal. This section describes 
how to configure your system, save and optimize graphics, and insert graphics into 
FrameMaker documents.

8.1 Configuring Your Computer
In order to maintain a consistent look for screenshots, configure your computer as 
described in this section. 

1 Assumptions:
● Windows 7
● Dell 22 inch monitor with a 1920 x 1080 recommended resolution

2 Set the screen resolution on the monitor you will use to capture screenshots:
a Right-click anywhere on your desktop, and then select Screen resolution.
b Click an image to select a monitor.
c In the Resolution list, select 1920 x 1080.
d Click Advanced settings.
e Click the Monitor tab. 
f In the Colors list, select True Color (32 bit).
g Click OK.
h If you are capturing screenshots on more than one monitor, repeat for the 

second monitor.
i Click OK.

3 Set the default color scheme:
a Right-click anywhere on your desktop, and then select Personalize.
b Scroll down to the Basic and High Contrast Themes area, and then select 

Windows 7 Basic.
c Click [X] to close the window.

8.2 DPI vs. PPI
DPI is an acronym for Dots Per Inch and is meaningful only for printed documents.

PPI is an acronym for Pixels Per Inch and is meaningful only for monitor displays.

For our documentation effort, we are attempting to create one source that is viewed 
both online and as a printed document. This creates a conflict in how best to capture and 
utilize graphic images. 

NOTE
Do not grab screenshots with the Windows 7 Aero Transparency enabled. 
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8. Figures and Images

Configuring Snagit

When viewing screenshots online, they look best when captured and viewed at the monitor 
resolution; however, when attempting to use the images optimized for online viewing in a 
printed document, they are often too big to fit on the 8-1/2 x 11 inch printed page. 

The question then becomes how best to scale the images to work for both online and printed 
documents. 

The current expectation is that the majority of our users will view the documentation online; 
therefore, capturing the images at the monitor resolution is desired. 

The Dell 22 inch monitor currently in use has a recommended resolution of 1920 pixels wide 
x 1080 pixels high, which equates to approximately 96 DPI. 

The maximum area on the printed page using our template is 6.25 x 7.25, which (at 96 DPI) 
is a maximum image size of 600 pixels wide x 696 pixels high. If you capture an area larger 
than this, it will not fit within the FrameMaker document margins unless you reduce the size. 

Here’s a link to a size/pixel conversion tool:

http://www.meilistudios.com/webapps/pixel-converter/index.php 

8.3 Configuring Snagit
The recommended screen capture program is Snagit 10. 

8.3.1 Specifying the DPI
Set your image capture resolution to 96 DPI:

1 Open Snagit.
2 On the menu bar, click Capture, and then select Input → Properties.
3 Click the General tab, and then select Clean title bar.
4 Click OK.
5 On the menu bar, click Capture. Ensure that Include Cursor is not selected.
6 In the Profile Settings area, click Effects, and then select Image Resolution.
7 Clear the Auto configure selection box.
8 Type 96 in the Resolution text box. 
9 Click OK. 
10 On the right of the Profiles area, click the green plus (+) to Save as New Profile. Type 

a name such as All-in-One, 96 DPI.
11 Click Save.
12 The next time you need to use these settings, simply click the saved profile. 

8.3.2 Using the Fixed Region Tool
The maximum image size captured with our monitor settings that fits on a printed page 
using our template without resizing is 600 x 696 pixels. To capture images at this size, or to 
use this tool as a sizing aid, perform the following steps:

1 Open Snagit.

TIP
You could create two screen captures for each image; one at 96 DPI and one at 
about 300 DPI. You would then apply a condition tag to hide the 96 DPI image in 
the printed version and hide the 300 DPI in the online version. This has been 
determined to require too much effort for the current documents. 

http://www.meilistudios.com/webapps/pixel-converter/index.php
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9

9. Tables

9.1 Blank
No defined use. Use if you have a need.

9.2 Figures
All figures are inserted in tables. This is so that they can be controlled in the online help. 
See “8. Figures and Images” on page 33 for instructions.

9.3 FiguresBorder, 
Same as figures, but with a border. 

9.4 FiguresBorderStep1, FiguresStep1
Do not use. Delete if found

9.5 Glossary Table Format
No longer used. 

9.6 Notification
Use the Notification table format for Cautions, Dangers, Notes, Tips, and Warnings. Refer 
to the following sections for more information.

● “Cautions” on page 13
● “Dangers” on page 17
● “Notes” on page 21
● “Tips” on page 25
● “Warnings” on page 26

The following notifications provide examples with definitions:

DANGER
Danger – A description of an imminent hazard that WILL result in severe
injury or death if not avoided. Limited to the most extreme situations.
When possible, include: 1) The action required to avoid the hazard. 2)
Details of the hazard. 3) The consequences of ignoring the warning.
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9. Tables

Notification

There are also options for English, French, German, and Polish. See the Reference Pages. 
Resize the columns to fit the language in the left column, and keep a 0.25 inch space 
between the right of the table and the right margin. For example, 1.25 inch and 4.75 inch or 
1.50 inch and 4.50 inch. 

If there are multiple languages in the same document, use multiple rows, and the Callout 
paragraph tag as shown below:

WARNING
Warning – A description of a potentially hazardous situation which if not avoided 
COULD result in serious injury or death. When possible, include: 1) The action 
required to avoid the hazard. 2) Details of the hazard. 3) The consequences of 
ignoring the warning.

CAUTION
Caution – A description of a potentially hazardous situation which if not avoided 
could result in minor or moderate personal injury. When possible, include: 1) 
The action required to avoid the hazard. 2) Details of the hazard. 3) The 
consequences of ignoring the caution.

CAUTION
Caution – A description of a potentially hazardous situation which if not avoided 
could result in minor or moderate damage to equipment or software. When 
possible, include: 1) The action required to avoid the damage. 2) Reason for the 
caution. 3) The consequences of ignoring the caution.

NOTE
Note – A note provides additional information that aid the user in the use or 
understanding of the equipment or procedure. They are not safety related. 

TIP
Tip – Provides clues that help the user do something. They are not required for 
the understanding or use of the equipment or procedure. They are not safety 
related. 

CAUTION
Risk of explosion if battery is replaced by an incorrect type. Dispose of 
used batteries according to the instructions.

PRUDENCE Une explosion risque de se produire si vous remplacez la batterie par un 
type de batterie inapproprié. Suivez les instructions pour vous 
débarrasser de la batterie.

VORSICHT Es besteht das Risiko einer Explosion, wenn die Batterie nicht mit dem 
korrekten Batterietyp ersetzt wird. Entsorgen Sie benutzte Batterien 
den Anweisungen entsprechend.
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10

10. Variables

This chapter describes document variables.

The following variables are defined for use in FrameMaker documents:

See “Creating Review Copies” on page 112 for information on when to update variables.

10.1 How to update FrameMaker Variables
The variables that change from release to release are described in this section. The 
variables that are on the master pages are described in “Master Page Variables” on page 
68. 

To update the variables in FrameMaker:

→ FrameMaker book file

1 From the book file, open front.fm.
2 Open the VARIABLES tab at the bottom of the FrameMaker window (Special →

Variables).
3 Click 1-DocRevision.
4 Click Edit:

Table 10–1  Variables 

Variable Value

1-CompanyName Wireless Seismic, Inc. 

1-CopyrightDate 2010-2014 (use en dash)

1-DocName The name of the document, for example Deployment Guide

1-DocRevision The revision of the document, for example R02 (released) or R02.a (first 
subsequent unreleased review).

1-PartNumber The part number of the document, for example xxx. 

1-ProductName The name of the product, for example RT System 2 (use non-breaking space)
CAUTION: Using non-breaking spaces when generating the online help causes 
RoboHelp to crash. Do not use NBSP in FM. 4/29/14: need to retest this with 
the TCS 5 software. It no longer crashes, but the resulting help displays the 
html code, and not a space. In WebWorks there was a way to over come special 
character issues, but I haven’t found this in RH. 

1-Published Date The date of release or review, for example July 9, 2014

1-Version The version of the product, for example v2.4.

1-Rights All rights reserved.
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10. Variables

How to update FrameMaker Variables

5 The ADD/EDIT VARIABLE window opens at the right of the FrameMaker window:

6 Type in a new variable and click Edit. For example, R02.b.
7 Click 1-PublishedDate and change it to the review date. For example July 9, 2012. 
8 Click Edit.
9 Click 1-Version and change it to the current version. For example, v2.0.0.
10 Click Edit.
11 Select all files in the book except for front.fm
12 Click File → Import → Formats.
13 Clear all check boxes except Variable Definitions.
14 Select front.fm in the Import from Document list.
15 Click Import. 
16 Save your files.

Figure 10–1  VARIABLES, Edit

Figure 10–2  ADD/EDIT VARIABLE Window
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12

12. Cross References

When the FrameMaker files are converted to RoboHelp, the heading, figure, and table 
numbering is not preserved. 

Although there are many cross reference formats defined in FrameMaker, we use only 
the following:

The page numbers are not used in RoboHelp, just the text.

Table 12–1  Cross Reference Formats 

Name Value Example

Heading & Page # <CrossReference>\`<$paratext>\' on page 
<$pagenum>

“12. Cross References” on 
page 63

Para # Only <White><$paranumonly>. <Default Font> 12. 

Step # & Page # <CrossReference>step <$paranumonly> on page 
<$pagenum>

step 2 on page 22

ChangeHistoryPage#Only page <$pagenum> page 63

See Also <CrossReference><$paratext><Default Font> See also: Seismic Terms

Step <CrossReference>step <$paranumonly> See step 4
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13

13. Style Examples

This section shows examples of the formats defined previously in this document. 

13.1 Heading1
Body Paragraph Body Paragraph Body Paragraph Body Paragraph Body Paragraph Body 
Paragraph Body Paragraph Body Paragraph

13.1.1 Heading2
Body Paragraph Body Paragraph Body Paragraph Body Paragraph Body Paragraph Body 
Paragraph Body Paragraph Body Paragraph

Body Paragraph Body Paragraph Body Paragraph Body Paragraph Body Paragraph Body 
Paragraph Body Paragraph Body Paragraph

Warning text Warning text Warning text Warning text Warning text Warning text 
Warning text Warning text Warning text Warning text Warning text Warning text 
Warning text ssss Sssss

Caution text caution caution caution caution caution caution caution caution caution 
caution caution caution caution caution caution caution 

Tip text Tip text Tip text Tip text Tip text Tip text Tip text Tip text Tip text Tip text Tip 
text Tip text Tip text

Body Paragraph Body Paragraph Body Paragraph Body Paragraph Body Paragraph Body 
Paragraph Body Paragraph Body Paragraph

Note text Note text Note text Note text Note text Note text Note text Note text Note 
text Note text Note text Note text Note text Note text Note text Note text Note text

Body Paragraph Body Paragraph Body Paragraph Body Paragraph Body Paragraph Body 
Paragraph Body Paragraph Body Paragraph

Body Paragraph Body Paragraph Body Paragraph Body Paragraph Body Paragraph Body 
Paragraph Body Paragraph Body Paragraph

→ Home > File > Menu

13.1.1.1 Heading3
Body Paragraph

Body Paragraph

13.1.1.1.1 Heading4
Body Paragraph

Body Paragraph

13.1.2 Heading2
Body Paragraph

Body Paragraph
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13. Style Examples

Heading1

Body Paragraph

13.1.2.1 Heading3
Body Paragraph

Body Paragraph

 Bullet
● Bullet1

► Bullet2
– Bullet3

13.1.3 Heading2
Body

13.1.3.1 Heading3
Body

13.1.3.1.1 Heading4
Body

 Bullet Box

 Bullet Box 1

 Bullet Box 2

13.1.4 Tables
For most tabular data, use the StandardTable format. The caption is above the table. The 
following table provides examples:

13.1.5 Figures
Figures are placed in a table cell with the caption below the figure.

Table 13–1  This Text Describes the Table

CellHeading CellHeadingCenter

CellBody CellBody

CellBodyCenter • CellBullet

NOTE: CellNote
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14

14. Master Pages

Page numbering is from 1 – n consecutively throughout the book. No chapter numbers, 
no roman numerals.

Chapters are numbered from 1 – n.

Appendices are numbered from A – Z.

Numbering and pagination is defined from the book file 

14.1 Chapter Pages
Use for chapters, appendices, and glossary, but not index. Appendices and glossary have 
alphabetical chapter numbers controlled by the book numbering properties. 

 First – Use for the first page in each chapter. This is the one with the squiggle. If 
your squiggle goes away, you may need to reapply the master page.

 Left – Use for all left-hand pages
 Right – Use for all right-hand pages

14.2 Index Pages
The index has no chapter number, but is listed in the TOC listing. 

 IndexFirst – Use for the first page in the index. This is the one with the squiggle. If 
your squiggle goes away, you may need to reapply the master page.

 IndexLeft – Use for all left-hand index pages
 IndexRight – Use for all right-hand index pages

14.3 Title Pages
Use only for the first two pages in the document:

 TitleRight – Use for the page that has the document information
 TitleDisclaimer – The back of the first page. Contains copyright information.

14.4 Applying Master Pages
If the pages don’t look right, for example the squiggle or headers/footers are missing, 
you should reapply the master page.

To apply or reapply a master page:

→ Open FrameMaker File

1 Click in the open FrameMaker document page.
2 Click Format, and then click Page Layout → Master Page Usage. The Master

Page Usage window opens:
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14. Master Pages

Editing Master Pages

3 Select one of the following master pages:
● Right/Left – Use these for the body pages that aren’t the first page in the chapter
● Custom – Select a specific master page from the menu

4 Select one of the following Apply To options:
● Current Page – Apply only to the current page
● Pages – Specify a page range. You can specify all of the pages and then select one

of the boxes to narrow the option.

See the FrameMaker help documentation for more information on FrameMaker features.

14.5 Editing Master Pages
Refer to the FrameMaker help for specific instructions. Access the master pages by clicking
View → Master Pages.

14.6 Master Page Variables
Refer to the FrameMaker help for specific instructions. The master pages use the following 
variables which should not need to be changed unless you are redesigning the template:

 Running H/F 1 – <$paratext[ChapterTitle,ChapterTitleNo,ListOf]>
 Running H/F 2 – 

<$paratext[Heading1,SectionTitleNoNum,SectionTitleNoNumNo,GroupTitlesIX,GlossaryLe
tter]>

Figure 14–1  Master Page Usage Window
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15

15. Reference Pages

Refer to the FrameMaker help documents for detailed instructions on Reference pages.

Although there are multiple reference pages defined by default in FrameMaker, the 
Wireless Seismic use of references pages is as follows:

 LOF – Used to define the indents and contents for the generated List of Figures file
 LOT – Used to define the indents and contents for the generated List of Tables file
 TOC – Used to define the indents and contents for the generated Table of Contents 

file
 IX – Used to define the indents and contents for the generated Index file
 Reference – Used to hold template graphics tied to paragraph tags and as a 

reference for other graphics.

When creating documents, you can open the reference pages and copy the graphical 
arrows used in the Navigation paragraph tag. There is no other reason you would need 
to open these pages.

In the Paragraph Designer, you can associate a graphic with a paragraph tag by 
selecting one in the Frame Above Pgf or Below Pgf menus. Refer to the FrameMaker 
help documents for more information.

Figure 15–1  Paragraph Designer
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16

16. Conditional Text

Conditional text is used to control how selected items appear in the output as follows: 

 Comment – Use to hide comments in released versions
 NotInOnlineHelp – Used to hide the Table Continuation variable in the online help 

and for special linked references to other documents. 
 OnlineHelpOnly – Used for special linked references to other documents and in 

some sections, create links that are helpful when the topic only is opened without 
the navigation pane showing. 

 FigureNotInOnlineHelp – Not currently used. Created to hide figures if necessary 
to reduce the size of the online help.

16.1 Applying a Conditional Text Tag
You can apply condition tags to control what text is seen in the output.

To apply a conditional text tag:

→ Open FrameMaker document

1 Click Special → Conditional Text → Conditional Text. The Conditional Text
window opens. 

2 Select the text.
3 In the Conditional Text window, click the Condition Tag name check box.
4 Click the check button.

Refer to the FrameMaker help documents for more information.

16.2 Showing and Hiding Conditional Text 
Once condition tags are applied to text, you can control what is seen in the output.

Figure 16–1  Conditional Text Window
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16. Conditional Text

Showing and Hiding Conditional Text

To show or hide conditional text:

→ Open FrameMaker document

1 Click Special → Show/Hide Conditional Text. The Show/Hide Conditional Text
window opens. 

2 Select the options and condition tags to show. 
3 Select or clear the Show Condition Indicators box.
4 Click Apply.

Refer to the FrameMaker help documents for more information.

Figure 16–2  Show/Hide Conditional Text Window
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17

17. Content

This section describes issues related to content.

17.1 List Order
When documenting window elements, keep the order the same as the window element; 
Left-to-right, top-to-bottom.

17.1.1 Lists and Menus
When documenting lists and menus, keep the bullets in the same order as the list. 

For example:

Select one of the following:

 Auto
 Auto-Source
 Normal
 Single

17.1.2 Toolbars and Buttons
When documenting toolbars, keep the order the same as the toolbar from left to right.

For example:

Click one of the following:

 Select All
 Print
 Export Selections
 Customize Columns
 Delete

Figure 17–1  List Order, Menu

Figure 17–2  List Order, Toolbar Buttons

Karla
Rectangle
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17. Content

Active Voice

17.2 Active Voice
Use active voice as described in the Microsoft Manual of Style. In addition, avoid the use of 
“will be” and “will” whenever possible.

 Use – Only one set is listed if you have not defined custom sets. 
 Don’t use – Only one set will be listed if you have not defined custom sets. 

17.3 Dashes and Hyphens
Use dashes and hyphens as follows:

 EM Dash – Use to set off phrases or parenthetical comments in sentences only: 
 EN Dash – Use as follows:

● A separator in Bullet paragraphs (space on either side)
● A separator in ranges of numbers: 100–200

 Hyphen – Use with compound words only: right-click

17.4 Key and Mouse Combinations
Use the Microsoft Manual of Style convention, except the following is allowed:

 Combine keyboard and mouse actions as if they were keyboard shortcuts.

SHIFT+CLICK 

Use the following:

 Right-click
 Left-click
 CTRL+CLICK

17.5 Navigation
Use graphic arrows to indicate navigation in Navigation paragraphs and other text. 

Specification:

 Arial font
 Space before and after
 Same point size as surrounding text
 Character Font = Right Arrow 

Shortcut key:

 ALT+26 = → 
 ALT+29 = ↔ 
 ALT+23 = ↨ 
 ALT+24 = ↑ 
 ALT+25 = ↓ 

17.5.1 In Text
Use the right arrow instead of words:
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18

18. Online Help

This section describes issues related to FrameMaker content.

18.1 Online Help
Source files are created in FrameMaker. All changes to content are made in FrameMaker. 
RoboHelp is used to convert the source files into an online help system. 

18.1.1 Required Folder Hierarchy
In order to have all of the different documents appear in the left navigation pane of the 
online help (merged WebHelp), the SVN folders must be organized and named as 
follows. In particular, do not change the “mergedProjects”, “parent”, or “projects” folder 
names—not even the capitalization:

 fm_files
● deployment_guide
● documents_guide
● glossary
● installation_guide
● operators_guide
● seismic_viewer
● system_description
● troubleshooting_guide

 rh_generate_files
● mergedProjects

► DeploymentGuide
► DocumentsGuide
► Glossary
► InstallationGuide
► OperatorsGuide
► SeismicViewer
► SystemDescription
► TroubleshootingGuide

 rh_project_files
● parent
● projects

► DeploymentGuide
► DocumentsGuide

CAUTION RoboHelp crashed if the non-breaking space was used in the product name 
variable. Take it out before trying to generate. 
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18. Online Help

Online Help

► Glossary
► InstallationGuide
► OperatorsGuide
► SeismicViewer
► SystemDescription
► TroubleshootingGuide

 rh_publish_files
● mergedProjects

► DeploymentGuide
► DocumentsGuide
► Glossary
► InstallationGuide
► OperatorsGuide
► SeismicViewer
► SystemDescription
► TroubleshootingGuide

18.1.2 Creating Updated Help
This section describes how to update the online help. 

To create a new version of the online help:

1 Check prerequisites:
 FrameMaker source files are up-to-date
 Updated PDF file exists

2 Delete all files in the following directories:
● SVN_Documentation\rh_generate_files\mergedProjects

► \DeploymentGuide
► \DocumentsGuide
► \Glossary
► \InstallationGuide
► \OperatorsGuide
► \SeismicViewer
► \SystemDescription
► \TroubleshootingGuide

● SVN_Documentation\rh_publish_files\mergedProjects
► \DeploymentGuide
► \DocumentsGuide
► \Glossary
► \InstallationGuide
► \OperatorsGuide

NOTE This structure was created after reading the following article: http://path/
RoboHelp/Merging WebHelp - RoboHelp 9.pdf 
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19

19. Process

This section describes issues related to process and procedures.

19.1 Creating Review Copies
When you start working on a document after a release or review, change the variables 
before you send it to review. Change them EVERY TIME you send something to review or 
release. 

Do not sent out review copies without updating the revision. 

19.1.1 Review Copies
Review copies have the revision of the form: 

R01.a

Where:

 R01 — Is the latest official released version
 .a — Is the current review version

If a document has never been released, it will have an R00 release number.

19.1.2 Released Copies
A released version has no alphabetic letter at the end. For example, R02. Now that we 
are updating and reviewing, it needs to have an alphabetic letter at the end until we 
officially release R03 (with the v1.2 product release). So the first review is .a, the 
second review is .b, and so on.

The most successful method for getting reviews is creating a Rally task and attaching 
the PDF file. 

Create a revisioned PDF of the ENTIRE document. You can split out separate files for 
review, but do not have different revision numbers in different chapters. The whole 
document is a revision. 

After the Release Candidate version is approved by the reviewers, create a final copy (no 
.a) and Daniel S will check it in to PDXpert. 

For technical notes and field service bulletins, include the Word file along with the PDF 
file. 

19.2 Using Watermarks
Use watermarks for review copies. Insert the watermark as follows:

 Draft – for review copies
 Preliminary – TBD 
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19. Process

Track Changes

19.3 Track Changes
In the FM docs you are updating (actually in Word docs, too), use both change bars and track 
changes:

Where they are in FrameMaker:

 Change Bars – From the book, select all of the files, select Format, Document, Change 
Bars. Select Automatic Change Bars.

 Track Edits – Open a chapter file. Use the toolbar to select a scope and to enable/
disable track edits. Do not enable all files in the book. Enable the chapter you are 
working on and then disable. 

19.3.1 Reviews
No defined process at this time. Work with the SMEs to get feedback. Create a user story 
with Subtasks for each book. Assign to Josh.

19.3.2 Searching for Tracked Text Edits
You can search in FrameMaker for tracked text edits.

To find the next tracked text edit:

→ Open FrameMaker document

1 Click Edit, and then click Find/Change.
2 From the Find menu, click Character Format Override.
3 Click Find to find the next tracked change.

Figure 19–1  Track Edits Toolbar

CAUTION
Disable all track edits for the book before saving the book file. FrameMaker will 
usually crash if you don’t. 
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20

20. Creating the Glossary

The Glossary is included in the online help as a separate document.

Insert a generic reference to the Glossary from the first chapter of the other documents. 
Delete any existing Glossary files from the book file.

As you create new user document sections, add terms and definitions to the tracking 
spreadsheet that need to be added to the glossary.

Include a section in all documents that is called “Related Documents.” In this section list 
the Documents Guide and the Glossary only.

Use the following conventions when working in the Glossary:

 The dividing letter uses the GlossaryLetter paragraph tag.
 The term uses the GlossaryTerm paragraph tag.
 The definition uses the GlossaryDefinition paragraph tag.
 Acronym entries:

● Use title case to define the letters only.
● Do not include a definition.
● Do not include a period

 Term entries:
● If there is an associated acronym, place it by at the beginning of the first line

followed by a period and then a space. 
● Place the definition after the acronym.
● In most cases, use lower case terms. Exceptions are usually proper nouns or

product-specific items such as “Armed.”
● If a term is specific to our product, preface it with the following:

“In the RT System 2 system,”.
● You can also preface definitions with other caveats such as:

“In seismic data acquisition, ”.
● The last sentence can be a reference to other terms. Begin the sentence with

“See also:” followed by a space. Insert cross-references to other terms. Use the
See Also Cross-Reference format.

NOTE
You must be very careful when defining terms to not copy and paste from 
copyrighted material. 

Even if you copy from an internal document, do an Internet search to make sure 
that it was not copied from a competitor’s site. 
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21. Indexing

At the minimum, create an index entry for each of the following:

 Acronym
 Task paragraph
 Keyboard shortcut
 Command in the Icons and Buttons reference chapter

Use one or two levels in the index:

definition
caution 13
note 21
tip 26

Disclaimer 16

Do not index every occurrence of a topic, just the main or introductory topic.
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22. QA Checklist

This chapter describes what to look for when checking the content for adherence to 
standards. 

The PDF files have slightly different formatting from the Online Help. See the following 
sections for more information:

 “Creating and Checking the PDF Files” on page 125
 “Creating and Checking the Online Help” on page 127

22.1 Creating and Checking the PDF Files

 Updates in FrameMaker

 Specify the Conditional Text 

 Hide: OnlineHelpOnly, UndefinedGlossaryTerm, and Comment

 Show: FigureNotInOnlineHelp (unless you’ve used it) and PartNumber and 
NotInOnlineHelp 

 Fix the variables:

 Add the non-breaking space in the variables 

 Create the PDFs

 QA the PDFs

 The Table of Contents Pane at the left shows chapter numbers (1. Overview, 2. Layout, 
etc.). If any are missing, the Chapter Title paragraph is missing the hidden number in the 
FrameMaker file. 

 Scan the Table of Contents and check for:

 Chapter and Heading numbering. It is sequential and no numbers are skipped. 
Appendices start over at “A”.

 The page numbers are sequential and do not skip or start over at 1. A new 
chapter starts on the correct page. Sometimes the numbering can be off since 
the source files are separate files. The document should number from page 1 
through 100 (or 400 etc.).

 The headings are not too long

 Chapter, Heading, Table, Figure capitalization is Title Case (vs Sentence Case) 
(French text doesn’t follow this convention).

 The headings seem to be constructed in a parallel fashion (Setting up the 
Backhaul, vs How to Set Up the Backhaul)

TIP
It is easiest to pick one thing and page through the document checking just for 
that. For example, check that there are no blank pages. Then pick another item 
and just check for that. For example, check all the footers.



126 Wireless Seismic, Inc. 2.5.0 Style and Process Guide Rev 00.k

© 2010-2014 Wireless Seismic, Inc. All rights reserved.

22. QA Checklist

Creating and Checking the PDF Files

 There are no blank pages.

 If there are links, they work.

 Headers and footers are on each page and consistent. The variable values are correct from 
chapter to chapter (version and revision in the footer)

 Conditional text settings. If these were not turned off before the PDF was generated, you 
might see some text that seems duplicated in a different color. 

 There are no Comments in a final copy (bold, red, starts with *****Q). OK in a review copy.

 There are no change bars in the margins of a final copy. OK in a review copy. 

 Graphics

 There are no missing graphics (sometimes there will be a box with a TBD in it).

 The graphic matches the caption

 The graphics are not chopped off. Sometimes this happens when there is a new 
screenshot but the anchored frame container is not resized. 

 The graphics are not fuzzy

 The Note/Caution/Tip/Warning icons are there and not oversized (see “Funny Icon” 
on page 14) or missing. 

 For the sections that describe a button in the toolbar, there should be a graphics at 
the beginning of section just below the heading. These graphics do not have 
captions. 

 All Figures have captions. 

 Do any figures seem too big for the page? Too small?

 Numbers

 Spot check some cross references and index entries to see the page numbering is 
correct.

 The numbered steps are sequential and don’t skip or start over. 

 Check that the content is formatted per the style guide:

 Each instructional section should have these paragraphs in the listed order preceding 
the steps:

► Task paragraph (To xyz:)
► Navigation paragraph (→ Home window)
► Step 1 is always 'Check prerequisites:'

 Tables

 All Tables have captions. Tables that continue to a second page have a continuation 
indicator. (cont.)

 Blank table cells have a dash

 The font size is consistent within the table. Sometimes the wrong paragraph tag is 
applied and some cells have a larger font. Especially in a cross reference. 


 Paragraphs

 The correct paragraph tags are applied (just scan and see if anything looks odd or 
inconsistent).
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